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About the documentation 
 

Introduction 
This manual gives an introduction to Archive Manager SharePoint Edition Enterprise Manager ï 
further referred to as Enterprise Manager ï the managerial tool for document archiving and 
backup and explains how to work with it. It is a user-friendly application of Archive Manager 
SharePoint Edition.  
 

Prerequisite knowledge 
Working knowledge of Microsoft Windows Server 2003/2008 is required. 

 

Archive Manager SharePoint Edition features 
 
With Enterprise Manager ï the managerial tool for SharePoint archiving and backup - the 
administrators can set many global and useful criteria for automated document archiving from MS 
SharePoint Portal (SPP) 2007/2010. Along with administrators, even individual users can archive 
their documents manually, provided they have been given such rights. All SharePoint operability 
remains unchanged for the end user. Archived documents in the application are still available to 
the user in the same way as before.  
 
Our software allows transparent archiving of documents, while preserving the existing structure 
folders and files on SharePoint Portal 2007/2010 untouched. It provides full version management 
with a possibility to restore any of the versions. Archived documents are replaced with a shortcut, 
thus not taking up so much space on the disk, yet documents are available for working with them 
as usual. Documents may be also restored back. Even restoring of deleted documents is 
possible.  
 
Further, with Archive Manager SharePoint Edition you may easily increase capacity on fast 
and expensive storage media by using cheaper slower ones. Archive Manager improves the 
system performance by reducing the SharePoint production database when it replaces SPP 
documents with shortcuts. The backup time for SharePoint environment is thus shorter. All 
document metadata (including internal document IDs) are preserved. Standard SharePoint 
Search works both for archived and non-archived content. Workflow functionality is not affected 
by archiving. Moreover, users still access archived documents directly from the SharePoint 
Portal.  
 
HSM as a storage mechanism allows storing of data (even all company data) on one or more file-
servers. Furthermore, it ensures that documents with identical contents are stored only once 
regardless of location of their respective original document (single instance storage). It is possible 
to use a shared store as well. 
NOTE: It is also possible to use OEM store instead of the HSM store. 
 
The system is fully automated. The user has to specify attributes of its behavior only. It enables 
centralized search through company data. This solution is faster and more efficient than 
searching through different machines/systems.  
 
There are no special settings necessary to allow archiving from SharePoint. With Archive 
Manager you can archive documents in supported web parts of MS SharePoint either manually or 
automatically. Automatic archiving is done via scheduled tasks ï jobs.  
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Supported MS SharePoint Portal web parts 
 
Supported SharePoint web parts can be accessed and archived with Archive Manager 
SharePoint Edition: 
 
SharePoint 2007 
 

Web part Support No 
support 

Document Library *   

Form Library *   

Wiki Page Library   * 

Picture Library *   

Translation Management Library *   

Report Library *   

Data Connection Library *   

Slide Library *   

Announcements *   

Contacts *   

Discussion Board  *  

Links   * 

Calendar *   

Tasks *   

Project Tasks *   

Issue Tracking *   

Survey   * 

 
SharePoint 2010 
 

Web part Support No 
support 

Document Library *   

Form Library *   

Wiki Page Library   * 

Picture Library *   

Asset Library *   

Report Library *   

Data Connection Library *   

Slide Library *   

Announcements *   

Contacts *   

Discussion Board  *  

Links   * 

Calendar *   

Tasks *   

Project Tasks *   

Issue Tracking *   

Survey   * 
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NOTE: Personal sites are also supported. It is possible to archive documents from them. The 
user running the Remote service (usually the SharePoint admin) has to be a Site Collection 
Administrator in the corresponding personal site. 
Generally, Archive Manager SharePoint Edition is able to archive from sites where the user 
running the Archive Manager services is a Site Collection Administrator. 
 
 

Supported MS SharePoint Portal metadata 
 
Following properties of SharePoint documents are archived: 

¶ SharePoint Portal Documentôs URL 

¶ Author who created the document 

¶ Document creation date and time 

¶ Recent user having modified the document 

¶ Document modified date and time 

¶ Display document name ï title 

¶ Comments 

¶ Document version number 

¶ Custom columns in document libraries to the appropriate MOSS folder 
o Preserving the value of user defined columns of Text, Note, Choice, 

Number, Integer, Date and User type 
o Lookup and Choice, simple ones and more advanced, connected to 

external data source 
o Multi-choice and Picture (URL) 
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Enterprise Manager 
 
Enterprise Manager is an administrative application of Archive Manager SharePoint Edition. 
With this application you may set many useful criteria for manual and automated document 
archiving (such as global and specific settings for automated archiving processes, e.g. you may 
specify when, in what way, and which folders will be archived automatically). On the other hand, 
archived documents can be restored anytime. 
 
IMPORTANT NOTE: It is important to have Archive Manager installed on every SPP front-end 
server (computer) whose documents you plan to archive. However, Enterprise Manager can be 
installed elsewhere to control the processes remotely! Furthermore, there can be several 
Enterprise Managers running in parallel. 

 
Run Enterprise Manager (click Start /Programs /Metalogix /Archive Manager SharePoint 
Edition /Enterprise Manager or run it from: Disk / Program Files /Metalogix /MAM4Share / 

FilePamManager, depending on its installation location). This will open the Enterprise 

Manager window.  
 
When running Enterprise Manager for the first time on a computer where Archive Manager is 
installed as well, the local computer is automatically displayed in the list box, and its 
corresponding tab is displayed next to the Home tab on the upper bar. 

 

 
 

As you may have noticed, the protocol of this local computer is by default set to TPC, and its port 
is by default set to 7777. 
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How to manage more Archive Manager servers  
 

More Archive Manager SharePoint Edition servers of the local network can be managed from one 
Enterprise Manager. They just need to be ñaddedò first: 

1. In the Enterprise Manager window, click on the Home tab. 
2. Click on the Add server button. 

 

 
 

3. Upon clicking the Add server button, the Select Computers window appears. 
 

 
4. Enter the name of the desired computer (Archive Manager server) in the text box. Then 

click the Check Names button. 

  

  



 

Manage, Migrate , Archive , Store , Protect  

 

  

www.metalogix.com/Support                  sales@metalogix.net                  Metalogix Software   9 / 103 

 

 

 
 

5. Confirm by clicking OK. 
 

6. The respective Archive Manager server appears in the list in the Enterprise Manager 
window, as shown below. Moreover, a tab with the respective server name appears on the 
upper bar. 

 
 

Now you are ready to configure connectivity settings for the respective Archive Manager server. 
 
NOTE: The upper bar in the Enterprise Manager window serves as a switcher between different 
Archive Manager servers. To manage a desired Archive Manager server, simply click on its tab. 

 
 

How to copy server settings 
 

You can use the Copy settings button on the right-hand side to copy settings of one Archive 
Manager server to another. 
Select the server which settings you want to copy. This will be the source. After clicking the Copy 
settings button, the wizard opens offering the following options: 
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¶ Manual ï this mode of the operation allows you to copy specific settings of the 
source 
Click Next to select settings which you want to copy, e.g. file compression 
settings as you can see on the screenshot below. 

 
¶ Automatic ï this mode of the operation will copy all settings of the source to 

the servers selected in the next dialog 
On the following dialog select the destination servers and click Next. 
When the process is finished, you can choose to save the log of the operation by clicking the 
respective button. Finally click Close. 
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How to configure connection settings  
 

To specify connection settings for a specific Archive Manager server: 
1. In the Enterprise Manager window click on the Home tab. Select the desired server in the 

list. Then click on the Configure button. 
 

 
 

2. In the Connection settings window, change the network protocol by clicking on the button 
located at the right (select either HTTP or TCP). 

 

 
3. To change the communication port, simply click on the arrows or enter a digit in the 

Communication port text box. 
4. Click OK to confirm. 

 
After adding an Archive Manager server (computer) in the list and upon specifying its connection 
settings, you may start managing it. To start managing it, click on its corresponding tab located 
on the upper bar. Sometimes, after clicking on the respective tab you might get a warning 
message (see the screenshot below). This shouldnôt happen normally. This means that the 
MAMfsaRemoteServerSv service is not running on the desired Archive Manager server (the 
MAMfsaRemoteServerSv service is responsible for remote connection to the respective server). 
Then you need to start this service on the remote server manually. 
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To make sure that MAMfsaRemoteServerSv service is started on the remote server, check it: 
 

1. Click Start /Settings /Control Panel /Administration Tools /Services  
2. Make sure that the Status column for the MAMfsaRemoteServerSv service is Started. If it 

is not started, then right-click that service and in the context menu select Start. 
 

 
 

When the connection settings for the desired server are set and the MAMfsaRemoteServerSv 
service is started there, you may click on the desired Archive Manager serverôs tab located on the 
upper bar to ñopenò that computer, i.e. to start managing it. 
 

  

   
 



 

Manage, Migrate , Archive , Store , Protect  

 

  

www.metalogix.com/Support                  sales@metalogix.net                  Metalogix Software   13 / 103 

 

 

 
 
Enterprise Manager then displays an interface through which documents can be archived, jobs 
can be scheduled etc. However, the SharePoint server (site) which you plan to manage has to be 
configured on the SharePoint tab (see ñSharePoint tabò). 
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Interface 
 
The layout of the interface is split into different sections. In the left you can see five main tabs: 
Archive, Scheduler, Restrictions, Settings, Post Processing and Statistics. The upper bar 
serves as a switcher between different Archive Manager servers. At the bottom there are 
Archive, Restore and Clear selection buttons, and the Versions bar, which can be unfolded by 
clicking on the arrow on the right. 
 
NOTE: If no folders or SharePoint nodes are displayed, the given SharePoint server (site) is 
probably not specified on the SharePoint tab (see ñSharePoint tabò). 
 

 
 
After clicking on the arrow on the Versions bar, it unfolds as shown below. It displays version 
information on document selected in the right pane. You can see there also the original 
SharePoint version number, who created the document and modified the document the last time.  
NOTE: The original SharePoint version number and other information are not available for 
documents archived with Archive Manager version 4.2 or below. 
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Manager icons and Undo button 
 

You may find the Refresh icon ( ) and Show deleted items icon ( ) at various places in 
Enterprise Manager. These icons are always located in the upper right corner (see the 
screenshot below). 
 
The Refresh icon is used to update the screen with recently saved information, i.e. whenever the 
Apply button is clicked. It is useful to click on it whenever you need to ñrefreshò the status on your 
screen. 
 
When you click the Show deleted items icon, items of the selected folder which have been 
deleted from the SharePoint Portal will be displayed in the list view. Such items will have an icon 

with small red cross attached to it: . 
 

NOTE: Different icon with a red sign attached to it ( ) denotes files that are not archivable in 
general or at the present moment; they are e.g. used by another program.  
 
The Undo button may be found as well at various places throughout Enterprise Manager. It is 

always located in the lower part of the window ( ). By clicking on this button you will 

discard all changes having been made since the Apply button ( ) was last clicked. 
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How to start using Enterprise Manager 
 

1. First of all you need to specify SharePoint servers (sites) which you plan to archive. 
When the Manager is started for the first time, it will ask you to configure the SharePoint 
connection in the pop-up dialog (see the ñSharePoint tabò section). Specified 
connections will be listed on the SharePoint tab. Only those connections can be further 
managed e.g. on the Archive or Scheduler tabs. 

 
2. Before anything is archived (either manual or automated) please specify first your 

restrictions related settings. You may do that on the Restrictions tab. For SharePoint 
Portal (SPP) archiving you can set which type of documents will not be included in 
archiving.  

 
3. Other important things to consider before archiving are the general settings. You should 

specify them at the beginning, before any arching is done. Simply click on the Settings 
tab create default retention category and set your criteria (see the section ñSettings tabò). 

 
4. Next proceed to Scheduler tab. There you can schedule jobs and filters for automated 
archiving (see the section ñScheduler tabò). 
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SharePoint tab 
 
All SharePoint servers (sites) which you plan to manage have to be listed on this tab. If the 
SharePoint server (site) is not listed here, it is not displayed on the Archive tab, i.e. it cannot be 
archived. 
 

 
 
To add your SharePoint servers (sites) click Add. 
In the pop-up dialog enter the SharePoint URL in the Address text box. 
Select the correct Target type ï SharePoint site or SharePoint server. 
Under Connect as choose to connect to the SharePoint either with current user or different user. 
The user must be Site Collection Administrator. 
Click Next. 
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In the following dialog define which SPP versions of the documents (Minor and/or Major) should 
be archive by Archive Manager. 
Check the Replace the latest version with shortcut if you want to create shortcut for the latest 
version of the archived document as well. If the check box is not selected the latest version of the 
document wonôt be replaced by the shortcut. This version will not be displayed in the Manager as 
archived. Finally click Finish. 
 

 
 
The SharePoint server (site) will be displayed on the SharePoint tab. Its configuration can be 
changed when you double-click the given icon or select the icon and click Configure. 
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Restrictions tab 
 

Under the Restriction tab you can specify: 

¶ all file extensions that are to be excluded from SPP archiving (Extensions tab). This 
means that none of the file types specified on this tab will be archived by Archive 
Manager. 

 

Extensions tab 
 
When clicking on the Extensions tab for the first time, both lists ï Restricted file types and 
Registered file types ï are empty (see the screenshot below). The left side (under Restricted 
file types) can be filled in manually, but that would be inefficient and time consuming. A much 
easier way is to build up a list of all file types located on the computer, and subsequently exclude 
those that should not be archived. 
 

 
 
 

How to exclude certain file types from archiving 
 
To exclude certain file types from archiving: 

1. Click on the Restrictions tab. 
2. Click on the Extensions tab. 
3. Click on the Build list button. 
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4. After clicking on the Build list button, all file types located on that computer will be 
displayed under Registered file types. 
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5. To add some of the registered files types among restricted ones, simply select them, 
and then click the Select from list button. Selected files types will be moved under 
Restricted file types. 
NOTE: Add files types to restricted ones also by double clicking the three dots and 
entering extension name (without the dot!)  
 

 
 

6. To confirm, click Apply. 
NOTE: If you have decided to archive certain already restricted file types, simply 
select them in the Restricted file types list, and then click on the Remove selected 
button (see the screenshot below). 
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Settings tab 
 
Before any archiving (either manual or automated) it is suitable to specify your settings regarding: 

o retention categories (different time spans for which archived items will be kept in the 
HSM store even if you mark them for deletion), the backup time (the time interval 
allocated during the day for making the backup of the database) and audit log on the 
General tab 

o email notification on the Notification tab 
o compression of files on the File compression tab 
o permissions for users on the User management tab 

 
 

General tab 
 
On this tab you may specify backup time, audit log, and different retention categories determining 
document lifecycle, i.e. archiving method, retention time etc. License information is also available 
here. 
 
WE STRONGLY RECOMMEND setting the Backup time first. This time is reserved for the 
database backup. During the backup period no information can be stored or requested; archiving 
process is stopped and will continue afterwards. Select the Backup time check box and then 
enter the desired period in the two text boxes. Please pay attention to this period, so that it is not 
set during working hours.  
 

 
 

If you want to get information about license validity, click the License information button. 
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Audit log 
 
If Auditing feature was installed, you need to enable it on this tab. To enable auditing, check 
Audit log check box. In the Auditing Server enter the name of the machine where the Auditing 
feature is installed and specify the Server Port (the default port is 7783).  
All actions made in the Enterprise Manager console create a log entry in the auditing database 
(except the ones made on the SharePoint tab). The audit logs can be viewed in the ArchiveWeb. 
The Auditing tab is visible just for permitted users.  
NOTE: For more information on Auditing see the ñAuditing manualò. 
 
Retention categories 
 
In the Retention categories section different retention categories for document archiving can be 
set. Various types of documents require different ways of archiving. The time for which they need 
to be stored and retrievable can differ as well. You can create retention category for short-term 
documents, retention category for long-term documents etc. In the following lines we discuss the 
usage of retention categories, their description and management. 
 
 
The retention categories which are created here can be assigned to jobs on the Scheduler/Jobs 
tab. They can be also used at manual archiving (see the ñArchive tabò section). Retention 
categories are defined through the following range of settings: 
 
Settings related to documents in the archive: 

 

¶ Retention time ï the archived document is not delete-able from the HSM Store for 
the defined time period. Retention time is thus the MOST CRUCIAL feature of 
Archive Manager related to law regulations. Documents ódeletedô in file system are 
still actually residing in the archive until this retention time expires. 

¶ Keep-alive time ï it is the time period after document deletion, during which the 
deleted document can be turned back to the file system. 

¶ Document expiration time ï the document, although not marked for deletion, is 
automatically deleted (by the Delete job) from the archive after the expiration of the 
defined time period. It is the MAXIMAL time for which the document resides in the 
HSM Store. This time period cannot be smaller than the retention time. 

 
 

Settings related to documents/shortcuts in the file system: 
 

¶ Keep the original document ï document is archived but it is not modified in any 
way (no icon, no shortcut, keeps residing in the system). This option is used just for 
backup. 

¶ Delete original document ï the document is REMOVED from the SharePoint 
system immediately after archiving; no shortcut is created; it is NOT ACCESSIBLE 
from the SharePoint; such unreferenced documents are accessible only in Enterprise 
Manager / Archive tab when you click the Show deleted items icon (right upper 
corner) or in ArchiveWeb. 

¶ Create shortcut ï the document is archived and it is replaced with a shortcut. This 
type of archiving saves the space and at the same time enables the user to work with 
the archived document just as with a non-archived one. Document can be replaced 
with the shortcut immediately or it is kept without changes for the defined time period 
and only after its expiration shortcut is created (ñDelay shortcut creation byò option). 
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o Delete shortcut after a time ï the document shortcut is 
automatically removed from the SharePoint after the expiration of 
the defined time period (user cannot reach it any longer in file 
system). However the document still resides in HSM Store. 

 
 
The shortcut has its pros and cons. Shortcuted documents save space in SharePoint. However, 
with often accessed documents the original file is retrieved frequently and the network traffic is 
high. With often accessed documents we recommend keeping no shortcut in SharePoint, but the 
file itself. It is important to balance high network traffic against fast file accessing. This task is 
effectively managed via Archive Manager shortcut lifecycle settings: 

¶ Create shortcut immediately ï shortcut is created at the time of archiving 

¶ Delay shortcut creation ï document is archived but still remains also in the 
SharePoint; only after a defined time period (when it is not eventually 
accessed so often any more) it is replaced by a shortcut 

¶ Create shortcut if the document was not used at least for ï similar as 
above: document is archived but still remains also in the SharePoint. Shortcut 
is created only after the document was not accessed for the defined time 
period. 

Further settings define the shortcut lifecycle: 

¶ Keep shortcut forever ï shortcut is left in the file-system 

¶ Delete shortcut after ï shortcut is deleted after the defined time period; keep 
in mind that after the shortcut is deleted, the document in NOT accessible 
from the file-system 

The ñDelete shortcut after a timeò feature can be used to reduce the number of ñredundantò 
shortcuts left in the SharePoint after a specific number of days, months or years. 
 
 

Archived document lifecycle: 

 
 
In addition to default retention category created during installation the administrator is able to 
create any number of retention categories satisfying specific criteria of the enterprise. Different 
retention categories are then assigned to different jobs. The retention category consists of a 
name, a description, the above mentioned retention settings and of the HSM scheme. It is fully 
manageable from Enterprise Manager. 
 
 

Creating a new retention category 
 
Retention categories created on the Settings / General tab can then be assigned to jobs on the 
Scheduler / Jobs tab. In this way various retention policies are applied. 
 

1. On the Settings / General tab click the Create button. 
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2. In the pop-up window enter the Category name, Description (optional) and select 
the Target schema in the dropdown box. In the HSM system you may define different 
HSM Schemas, which are virtual categories for documents. (One HSM Schema has 
been created at the installation of Archive Manager and you may have created more 
HSM Schemas, each with a particular number assigned to it.) Click Next. 

 

 
 

3. In the next dialog define the document lifetime in the archive: 

¶ Document lifetime begins with ï select the document lifetime starting point; this 
will be the outset of Retention time and other defined time periods; it may be the 
Files creation time, Archiving time or Last modification time 

¶ Retention time - during this period none of the documents in the HSM store 
(archived via this retention category) can be removed from the archive; 
documents can be only marked for deletion before this time elapses and such 
documents will be deleted only after this defined time period 

¶ Keep alive time ï this is the time period (after the retention period) for which the 
document will be still kept in the HSM Store although it was marked for deletion 
and is ready to be deleted. It is a security feature which enables administrator to 
recall the deletion if necessary. It can be set in days, months, years. 

¶ Enable document expiration after ï check the check-box if you want to 
COMPLETELY DELETE archived documents whose retention time has elapsed 
from the archive. Define the expiration time here which has to be longer than the 
Retention time. If the expiration time is not set, documents NOT marked for 
deletion keep residing in the archive 

¶ Limit the number of archived versions ï select if you want to set how many 
versions of a document the system should keep in the archive; then set the 
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number of versions (x); if x+1 version is created, the oldest version is marked for 
deletion and replaced by the new one  

Click Next. 
 
NOTE: For more information see the preceding section - ñRetention categoriesò. 
 

 
 

4. Shortcut lifetime dialog incorporate file-system side settings: 

¶ Keep the original document ï documents will be just copied to the archive; no 
change in the SharePoint 

¶ Delete the original document ï documents will be moved to archive and will not 
be accessible in the SharePoint 

¶ Create shortcut ï the document will be archived and replaced with a shortcut 
In case you have selected the Create shortcut option, further settings become available and you 
can adjust shortcut behavior to meet your needs. You can choose if the shortcut creation will 
follow immediately after archiving of the document (Create shortcut immediately radio button) 
or will be delayed for the specified period of time (Delay shortcut creation by radio button). 
Moreover, you can decide whether you want to keep the shortcut in the SharePoint until the user 
deletes it (Keep shortcut forever option) or the shortcut will be deleted automatically after the 
defined time (Delete shortcut after a time option). 
Click Next. 
 
NOTE: For more information see the preceding section - ñRetention categoriesò. 
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5. Additional settings dialog is displayed. If the Set the retention category as default is 
checked, this category will be used at manual archiving in SharePoint or Enterprise 
Manager. If the Enable automatic deletion of unreferenced documents check box 
is selected, documents archived via this category will be marked for deletion 
whenever the Synchronization job cannot find the reference (shortcut) to the 
document in the SharePoint. If the check-box is not selected, Synchronization job will 
not mark eventual unreferenced documents for deletion (see the section ñHow to 
define a jobò). 
Click Finish. 

 
 

Example: 
 

I. Documents are archived by a retention category with Enable automatic deletion of 
unreferenced documents checked and shortcuts are left in the SharePoint 

II. You delete shortcuts from SharePoint Ÿ documents become unreferenced 
III. The Synchronization Job runs Ÿ unreferenced items are marked for deletion 
IV. Items marked for deletion are deleted from archive when their Retention (and Keep alive) time 

elapses and the Delete job runs 
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Notification tab 
 

The e-mail notification feature helps you to be always informed about your scheduled jobs and 
receive emails with up-to-date data regarding job running. For this purpose you need to: 

1. configure the notification settings on the Notification tab  
2. enable notification for jobs about which you wish to be notified. This is done on the 

Scheduler / Jobs tab in the Job properties section. (See ñHow to define a jobò.) 
 
The notification email contains the basic Job(s) properties and a note if any errors occurred 
during the job running. The report is sent as an attachment. 
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Check Enable e-mail notification check box to allow notification. 
 
Use the Send e-mails about job status switcher to choose between Daily, Weekly or 
Immediate notifications. Should you choose the Immediately option, the notifications will be 
send just after the job stops running.  
In the following text boxes specify the day of the week for weekly notifications and the time for 
daily/ weekly notifications. The notification email will be send at the specified time.  
 
Check Compress daily/weekly logs larger than 100kB, too. Archive Manager will try to pack 
the huge summaries with ZIP in order to reduce the size of the sent email. To do so, you will 
need Microsoft Visual J# Version 2.0 Redistributable Package installed on the server. If you 
experience any problems using this feature, e.g. the mail is not sent, please try installing the 
above mentioned package or simply uncheck the check box. 
 
In the last section enter the SMTP server, port, account - user name and account - password 
in the respective text boxes. 
NOTE: The SMTP server can be your Exchange Server. 
 
To confirm, click Apply. 
 
Finally click on the Send test mail button to test the connection and the data you have entered. 
The addressee defined should receive a test mail in a few seconds depending on the SMTP 
server. 
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File compression tab 
 
On this tab the administrator may specify files, with regard to their size, which will be compressed 
during archiving process. It is also possible to exclude certain file types from compression. 
 

How to set compression criteria with regard to the file size  
 

1. Click on the Settings tab. 
2. Click on the File compression tab. 
3. Select the Compress files by default check box. (This is crucial otherwise no 

compressing will take place.) 
4. Select the Compress files by size check box. 
5. Enter values in the Compress files if their size is between n bytes and n kilobytes 

boxes. 
 

 
 
IMPORTANT: Providing that the Compress files by default check box is unselected, no 
compressing will take place. 
 
 

How to exclude certain file types from compressing 
 

1. Click on the Settings tab. 
2. Click on the File compression tab. 
3. Click on the Build list button.  
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4. After clicking on the Build list button, a list of all file extensions gets displayed in the 
right list box. Select the desired ones and then click on the Add button. After clicking 
on Add, the respective file extensions are moved in the Do not compress file types 
list box. 
NOTE: The administrator may also double-click the three dots and then enter the 
desired file extensions (without a dot!). 
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5. Click Apply to confirm.  
NOTE: Should you wish to include for compressing some already excluded file types, 
simply select the respective file extensions in the Do not compress file types list 
box and then click on the Remove button.  

 

User management tab 
 
On this tab the administrator may specify usersô permissions for Enterprise Manager features. 
This means that individual users can be given permissions to archive/restore documents, to 
restore versions, to mark versions for deletion, to change jobs etc. 
All such rights should be specified individually for each machine. New machines / users can be 
added onto this tab (in order to manage usersô permissions) simply by using the Add button.  
 
To enable rights: 

1. Click on the Settings tab. 
2. Click on the User management tab. 
3. Select the desired user account in the left pane.  

 

 
 

4. In the left pane select the user account whose permissions you want to manage. 
Then in the right pane Allow or Deny individual Archive Manager features and 
functions for the selected user, e.g. to enable a user to mark archived files in the HSM 
store for deletion, allow Mark for deletion/Remove deletion mark from a version. 
NOTE: To allow or deny all settings at once use the Allow All and Deny All check 
boxes. 

5. To confirm, click Apply. 
NOTE: By clicking on the Undo button you will cancel all changes that have been made since 
you last clicked Apply. In other words, by clicking Undo you will restore what has been recently 
changed. 
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Scheduler tab 
 
This tab is used for configuring purposes, in other words the administrator may schedule jobs that 
would automatically archive different folders/disks with predefined settings and retention. Jobs, of 
course, need to be created up-front, and only then they can be assigned to supported folders on 
SharePoint Portal. Should you wish to archive documents for instance with regard to their 
extension, create filters and apply them to folders/disks. All those specifications can be defined 
on the Jobs and Filters tabs as described further. 
 
 

Jobs tab 
 
As mentioned above, jobs need to be created up-front. 
After clicking on the Jobs tab you will see it split in five parts (sections): Scheduler jobs, Job 
properties, Folders, Filters and Filter properties. 
When running Enterprise Manager for the first time, there are no jobs specified, thatôs why this 
tab is empty (as shown below). Later, when jobs have been defined, they would be displayed 
under Scheduler jobs. 
 

 
Following sections deals with job creation. The process is as follows: 

1. Job is defined and its properties are set. 
2. Job is assigned to folders which should be processed. 
3. Then a filter can be created and assigned to a folder. 
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How to define a job 
 

1. Click on the Scheduler tab. 
2. Click on the Jobs tab. 
3. Click on the Create button. 

 

 
 

4. In the Create new job window enter a name for your job in the Job name text box. 
Then select the type of the job in the Job type drop-down box. Afterwards click OK. 
NOTE: There can be defined several types of jobs: Archive, Delete, SPRestore, 
SPSynchronization, SPShortcutConverter and ShortcutCreator. 
 

 
 
 

As mentioned above, several types of jobs can be created. First two types apply to SharePoint: 
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¶ Archive - does archiving with specified settings 
 

¶ Delete ï main features:  
V deletes documents marked for deletion in the HSM store (archive), if 

their retention period and keep alive time has expired 
V deletes documents from the archive if their expiration time elapsed 
V for both above mentioned cases, the job deletes also shortcuts from the 

file system when the corresponding document is deleted from the 
archive (optional feature; default itôs ON) 

V deletes shortcuts after a defined time where Delete shortcut after feature 
was enabled (see the section ñRetention categoriesò) 

Delete job can run on folder basis, i.e. process just specified folders. It can 
run in different modes, too: 

o Reporting ï no action is taken, just a report is generated. The 
report contains the list of files which are going to be deleted. The 
report can be checked and modified if necessary. It can be found 
under <installdir>\Metalogix \MAM4Share \fsaPamLogs \delete 
\ delete.report 

o Process report mode ï files from the previously generated (and 
modified) report are processed 

o Process immediately mode ï processing files without any report 
(not recommended) 

 

¶ SharePointRestore - does restoring (moving back archived files into the 
SharePoint content database) with specified settings. This feature is useful 
mostly in cases if you would like to change the archiving policies. For 
example, in the past everything older than 6 months has been archived to 
EBS. The new policy is archiving all documents older than 12 months. With 
this job you copy all documents having the age from 6 to 12 months back to 
the SharePoint content database. 

 

¶ ShortcutCreator ï creates delayed shortcuts; some documents may have 
been archived with retention category where the Delay shortcut creation by 
or Create shortcut if the document was not usedé option was selected; such 
items were copied to archive but the shortcuts are created after a defined 
time period 

 

¶ SharePointSynchronization ï this job crawls the Archive Manager 
database compares it to the selected SharePoint sites and folders and can 
mark files and versions which have been deleted from SharePoint for 
deletion. 
SharePointSynchronization job can run on folder basis, i.e. process just 
specified folders. It can run in different modes, too: 

o Reporting ï no action is taken, just a report is generated. The 
report contains the list of files which are going to be deleted. The 
report can be checked and modified if necessary. It can be found 
under <installdir>\Metalogix \MAM4Share \fsaPamLogs \ 
\Synchronization job\Synchronization job.report 

o Process report mode ï files from the previously generated (and 
modified) report are processed 

o Process immediately mode ï processing files without any report 
(not recommended) 
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NOTE: Keep in mind that the job processes all files twice, once it crawls the 
database, second it goes through the SharePoint. The performance rate is around 50-
200 docs/sec, depending on server capability and load. It can take days to run it on 
millions of archived/non-archived files, so, plan the schedule carefully. You may 
experience high disk and database load. 

 
 

¶ SharePointShortcutConverter ï In case you are upgrading from Archive 
Manager 4.2 or older, running this job once is mandatory. The job converts 
all old Archive Manager shortcuts into new EBS shortcuts. Otherwise it can 
happen that old SharePoint shortcut files wonôt be restored after opening. 
 

 
Further we describe how to specify job properties and explain individual features. Please note 
that not all settings apply to every type of job. 

 
5. In the Job properties section you need to specify details about particular job (e.g. 
retention period; schema ID; you may ñturn a job onò / ñturn a job offò, etc.). To ñturn a 
job onò, click on the Enabled field. Click on the down arrow to unfold the down-drop 
box and select True. Job will be turned on.  

 
Number of threads field specify the number of threads in which the given job run. It 
is accessible for Archive job. This feature can fasten up archiving and is 
recommended to be used. The default value for a new job is 4, the maximum value 
for one job is 16. 
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6. In the Notification section you can activate email notification for the given job. Click 
on the E-mail notification field and in the down-drop box select True. Archive 
Manager will be sending notifications about this job as configured on the Settings/ 
Notification tab. In the Notification type field choose either Detailed type of 
notification or Summary for summarized notification. 

 
 

7. In the Retention category field assign a retention category to the job. Retention 
categories define the document lifecycle. This setting is available for Archive jobs. 

 
NOTE: Retention categories are created on Settings / General tab.  
 

8. The Operation section is available just for the Delete and SPSynchronization job to 
specify its settings. 
Click on the Operation mode field. Then click on the down arrow and select the 
operation mode: 

o Reporting mode - no action is being taken just a report is generated. 
This is useful as administrators first have a report on what is going to 
be done. The report can be checked and modified if necessary. 

o Process report mode ï files from the previously generated report are 
processed. Administrator is able first to check and modify the list of 
files going to be processed (i.e. deleted) 

o Process immediately mode ï processing files without any report (not 
recommended) 

The Report file field displays the path to the generated report 
(e.g.<installdir>\Metalogix \MAM4Share \fsaPamLogs \delete \ delete.report). 

 
Settings for Delete job: 
If the Delete shortcuts field is set to ñtrueò, files which are going to be deleted from 
the archive will also have its shortcuts deleted from the file system. 
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9. To schedule archiving, click on the Start at field. Then click on the down arrow and 
select a day on the calendar; select the desired month by clicking on the side arrows; 
and specify the desired time in the text box. 
To enter the last day when the job should run, click on the End at field. Afterwards 
click on the down arrow to open the calendar and select the desired month and day. 
NOTE: Should you select the Infinite check box, job would be running infinitely. 
Then press Enter. 
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10. To specify how long the job should run, click on the Run interval field. Click on the 
down arrow to open the drop-down box and then specify the period in minutes, hours 
or days. 

 
To specify the maximum time span during which the job will be running, click on the 
Maximum run time field and specify your requirements (e.g. enter 3 and the job will 
be allowed to run for a maximum of 3 hours.). If you leave Unspecified, then there is 
no limitation as to time span. 
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Created jobs can now be assigned to folders to automate folder archiving. 
NOTE: To change the properties of the job, it has to be stopped first. 
 
 
 
 
 
 
 

How to assign a job to a folder 
 

To automate folder archiving, assign jobs to them. 
1. Click on the Scheduler tab. 
2. Click on the Jobs tab. 
3. Select a desired job in the list in the Scheduler jobs section. 
4. Select a desired folder, either recursively or non-recursively, in the Folders section. 

 

  



 

Manage, Migrate , Archive , Store , Protect  

 

  

www.metalogix.com/Support                  sales@metalogix.net                  Metalogix Software   41 / 103 

 

 

 
5. Click Apply. 

NOTE: By unfolding the Folder overview tab you may see what folders the currently 
selected job is assigned to.  
 

How to start the job immediately 
 
Job starts running automatically as it is set in Job properties (see the previous section). 
However, you can start the job manually any time: 

1. On the Scheduler / Jobs tab select the relevant job in the Scheduler jobs 
section. 

2. Click the Start button below the list view. The job starts running immediately. 
NOTE: You can also stop the job by using the Stop button. 

IMPORTANT NOTE: If the job was stopped, it remembers which document was the last 
processed document. When it is started again, the job starts processing documents from this last 
processed document.  
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Filters tab 
 
By using filters you may specify which of the documents will be archived and in what way. Before 
using any filters they need to be created on the Filters tab.  
 
When you switch to this tab, you will see the window split in two parts. On the left, there is a list of 
all filters displayed (when Enterprise Manager is running for the first time, the list is empty!). On 
the right you will see their properties. 
 

 
 
 
 

How to create a filter 
 

1. Click on the Scheduler tab. 
2. Click on the Filters tab. 
3. Click on the Create button to open the Create new filter window.  
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4. In the Create new filter window enter the name in the Filter name text box. Then 
click OK. 
 

 
 

5. After clicking OK the following window is displayed. 
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NOTE: Exclude attributes field does not apply for SharePoint. 
 

6. Click on the Include file types field. Then click on the down arrow to unfold the 
dropdown box. Here you may specify the type of files to archive. Simply double-click 
the three dots and enter the desired extension (without a dot!). Then press Enter. 
NOTE: If you leave this field empty, all file types will be archived. 
 

 
 

7. Click on the Maximum size field. In the adjacent field enter the maximum size of 
documents (in kilobytes) to be processed. 
NOTE: Should you enter Unspecified, then there are no limitations regarding the 
size of documents to be processed. 
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8. Similarly, click on the Minimum size field, and in the adjacent field enter the minimum 
size of documents (in kilobytes) to be processed. 

 
9. Click on the Older than field. Then click on the down arrow to unfold the dropdown 

box. You may filter documents according to time of their creation/uploading or 
modification.  
Should you enter Unspecified, then there are no limitations regarding time. 
 
NOTE: For the SharePoint documents: 

¶ last access date or last modification date is a date of last modification of 
the document 

 
 

10. And finally, in the Filter name field you may change the name of the filter anytime. 
 

11. SharePoint section:  
In the Include versions field define which SPP versions of the documents (Minor 
and/or Major) should be archive. These settings override version archiving set at the 
SharePoint tab. If Undefined is selected, SharePoint tab settings are applied. 

 
In the Replace the latest version with shortcut field specify if you want to create 
shortcut for the latest document version at archiving. If No is selected the latest 
version of the document wonôt be replaced by the shortcut. This version will not be 
displayed in the Manager as archived. These settings override settings at the 
SharePoint tab. If Default is selected, SharePoint tab settings are applied. 

 

 

 
 




















































































































